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Installing and signing in 

Installing the application 

Pre-requisites for Refinitiv Eikon 

1. Go to https://customers.refinitiv.com/Eikon. 

2. Click Check My Computer. 

3. Follow the on-screen instructions to run System Test. 

Getting your Refinitiv Eikon account 

1. Your company’s Market Data team or Refinitiv Account Manager requests a Refinitiv Eikon ID on your behalf. 

2. You receive a Welcome email from Refinitiv Eikon. 

3. Click the link in the Welcome email to activate your account. 

Installing Refinitiv Eikon 

After checking that your computer meets the requirements and activating your account, you are ready to install 

Refinitiv Eikon: 

1. Go to https://customers.refinitiv.com/Eikon/ 

2. Click Sign in & Download. 

3. Follow the on-screen instructions to install Refinitiv Eikon. 

Signing in 

On your desktop 

1. Point to Start > Programs > Refinitiv and choose Refinitiv Eikon. 

2. Type your user ID  and password . 

 

1 
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3. Select Sign me in automatically  to avoid signing in the next time you start the application. 

4. Click Sign In.  

On your mobile device 

The single sign-on (SSO) feature with single exchange fees lets you access Refinitiv Eikon on iOS, Android, and 

BlackBerry devices. 

 For eLearning, go to https://training.refinitiv.com/eikon/mobile-solutions 

On the web 

You can now access key Refinitiv Eikon news and data on the web, without having to download an application. 

Just go to http://eikon.refintiv.com/login and use your user ID and password. 

 For eLearning, go to http://training.refinitiv.com/video/v.php?v=1378 

Contact Support 

If you cannot sign in 

Unable to sign in? The most likely cause is an incorrect password or no Internet connection. 

After logging in, you can always access help by pressing F1 or using the right-click menu. 

Should none of these solutions work, contact Refinitiv: 

1. Click the Contact Us link in the Sign In dialog box. 

2. Fill in the Contact Us page that appears, and click Submit. 

Getting support after signing in 

If you encounter problems when working with Refinitiv Eikon or receive error messages and would like more 

information, you can contact Support. 

Go to  > Help > Contact Us. 

Getting more help 

• Click  in the top right of your toolbar to find out what’s new in Refinitiv Eikon.  

• Go to  > Help for all help-related options. 

• MyRefinitiv is the single online entry point to Refinitiv service and support. You can find numerous 

documents, including the latest version of this guide. 

https://training.refinitiv.com/eikon/mobile-solutions
http://eikon.refintiv.com/login
http://training.refinitiv.com/video/v.php?v=1378
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Getting training 

Type TRAINING into the Search box to open the Training App: 

• View on-demand video tutorials to help you get the most out of Refinitiv Eikon. 

• Learn the basics so you can get up and running quickly. 

• Explore learning by segment to ensure you are making the most of the tools available for your market. 

• Bookmark training so you can complete it at a time convenient to you. 

 

Customizing your profile 

Creating your profile 

When you sign in for the first time, Refinitiv Eikon prompts you to customize your profile. Be sure to fill in Job 

Functions and Asset Classes: this information is used to suggest the features and apps most appropriate for your 

role. 
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Updating your profile 

You can edit your profile information at any time. 

Go to  > Preferences > My Profile to reopen your profile page and make your changes. 
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Basic Navigation 

Getting to know the toolbar 

Immediately after logging in, the toolbar appears at the top of your screen. 

 To move the toolbar, just right-click it and choose Undock, then drag it to a new position. 

 

 Refinitiv Eikon button. Click here to access the app menu, App Library, saved workspaces, settings, and 

Help. 

 The Search box is powered by Autosuggest and Answers. Use it to find apps, data, or answers to your 

questions. 

 What’s New in Eikon 

 Favourites 

 Alerts 

 Open workspaces appear here. Workspace 1 is open by default. 

 You can create, save, close, or load workspaces. 

 Messenger 

 My Briefcase 

For eLearning, choose Getting Started with Eikon: New User from the Learn the Basics category in the 

Training App. 

  

1 
2 

3 4 5 

6 7 8 9 



Basic Navigation 
 
 
 

Refinitiv Eikon Quick Start Guide 

9 

      

Finding apps and defining settings 

 Click to open the app menu. 

 My Apps features apps for your specific 

asset class. You can add, remove, or 

rearrange apps in this menu. 

 Other apps are displayed by category. 

 Click Help to access online help, to contact 

us, to find out what’s new, and other support 

options. 

 Layout holds all your saved workspaces and 

layouts 

 The App Library is a searchable database of 

all apps. 

 Click Settings to define global options, 

trading settings, and more. 

 Click Help to access online help, to contact 

us, to find out what’s new, and other support 

options. 

 

Searching for content and getting answers 

Search box: a starting point for your workflow 

The Search box is your starting point to 

navigate anywhere. Just start typing and 

Autosuggest will propose results. 

 Start typing Vodafone in the Search box. 

 Autosuggest displays results. 

 Click a result to load content. For 

example, you can open the Chart App 

with data for Vodafone already loaded. 

 If you don’t find what you are looking for, 

press Shift+Enter or click here to run an 

advanced search. 
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Sample searches 

Company names or common abbreviations Microsoft, Vodafone, ibm 

Descriptive terms Comex copper, vodafone common stock 

Standard industry codes Ticker, ISIN, Cusip, Sedol, WERT 

Specific and partial codes US4592200HJ3, MSFT, USTB 

Ticker, coupon, and maturity VOD >7.5%, Vodafone 2015 

Country names for country guides France, UK, Japan 

News searches on specific instruments or topics IBM news, China news, UST news 

Answers: asking your questions in natural language 

Type a query using natural language. Refinitiv Eikon Answers will appear at the top of the results. 

 

 For example, you want to compare recent top-line trends for Ford and GM. Type Ford vs GM sales. 

 Autosuggest interprets your query. ANS prefixes results from Answers. Click the result that matches your 

question to view a detailed revenue chart comparing Ford and GM. 

 You can find answers to frequently asked questions. Start typing How do I... and you will see FAQs in the 

Search results. 

Sample Answers queries 

Ford vs GM sales 

Google EBITDA estimate 

French tech companies 

 For more help and to see examples, type ANSWERS in the Search box and choose the top result. 

  

1
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Bookmarking your favorite content for easy access 

Add apps and other content to your Favorites for easy retrieval later on. Open the Favorites Center by clicking the 

Favourites button in the top right of any screen. 

1. Open an app. 

2. Right-click the app.  

3. Click Add to Favorites.  

4. Give your Favorite a name , choose a folder to save it in (or create a new one). 

5. Click Add  to save it. 

 

 Use the Right-Click Favorites folder and your Favorites will be available in the right-click menu of any app. 

2

3

4

5



Using your floating workspace 
 
 
 

Refinitiv Eikon Quick Start Guide 

12 

      

Using your floating workspace 

Refinitiv Eikon – Version 4 features a floating workspace that displays multiple apps of your choosing. This 

flexible format means you are not restricted to one size or shape, and can customize screen real estate to suit 

your needs. With just a few clicks, you can: 

• add the apps you want 

• size them to meet your requirements 

• “snap” them together so that they move as a single entity 

• stack them to create tabbed windows so that you can flip back and forth 

• arrange them around other applications such as Microsoft Excel or Outlook 

• link them together so that they share data 

Exploring apps for your asset class 

 My Apps gives you one-click access to the apps 

most frequently used in your asset class. For 

example, default apps for an equities trader 

include Quote List, Option Watch, and Time & 

Sales App. 

 Other categories help you find the apps suited to 

your workflow 

 Click App Library to view the full list of available 

apps. 

 You can rearrange apps in My Apps by dragging 

the icons and dropping them to a new location. 

You can also add or remove apps. 
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Browsing the App Library 

 Begin typing an app name in the 

Search box. Results appear 

below. 

 Choose a Category or Asset 

Class  to narrow down your 

results. 

 Click on the Favorites icon to add 

an app to My Apps for faster 

access. 

 

 

 

 

 

 

 

 

 

 

 

Setting up your workspace 

Creating a new workspace 

 

 Click a workspace name to make it the active workspace. You can have up to ten workspaces open at any 

time. 

 Right-click a workspace to save, close, or rename it. 

 Click Show Workspace Menu to: 

o add a new workspace 

o access templates for different asset classes 

o share and save workspaces 

1

2

3

4

1

2 3



Using your floating workspace 
 
 
 

Refinitiv Eikon Quick Start Guide 

14 

      

Adding apps to your workspace 

When you open an app by selecting it in the app menu, the App Library, or through the Search box, it 

automatically becomes part of your active workspace. 

This example includes a Quote List, Option Watch, and News Monitor: 

 

 The active symbol (in this case, Oracle <ORCL.K>) is the most recent financial instrument you have focused 

on. When you add an app, it automatically displays data for the active symbol. 

 Click an app title bar to move the app. Click and slowly drag an app until its frame touches another app: the 

two apps “snap” together, and you can move them around as a single entity. 

 Add News Monitor to your workspace to get: 

o the latest market-moving news 

o historical news archives 

o feature-rich, intuitive user interface 

 Resize an app as you would any other window: just click the frame and drag to the new size. 

 Use auto-stacking so that new apps open automatically as tabs in the same window. This saves screen real 

estate. Go to > View > Auto Stack Window to turn auto-stacking on. 

 For eLearning, go to choose The News Monitor App from the Price & News Discovery category in the 

Training App. 
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Linking apps together 

You can link apps together so that they share the content of your chosen instruments. Color-coded apps “tune in” 

to the same data stream. 

 

 This example includes Index Movers App, Quote Line App, and a company overview page. 

 In the top left of each app, click Link Channel to choose a color. Choose whichever color you prefer. 

 

 Now that the apps are linked, type a new instrument code into any app. All other apps will automatically 

display content for the new instrument. 

 For eLearning, choose Managing the Eikon Workspace from the Learn the Basics category in the Training 

App.  

1
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Saving or sharing your workspace 

After creating your workspace, you can save it for later use or share it with colleagues. Just right-click the 

workspace tab in the application toolbar and choose Save. You will also be prompted to save any unsaved 

workspace changes when you close Refinitiv Eikon. 

 Right-click the workspace tab and choose Save. 

 

 To see your saved workspaces, click View 

Workspace Menu. 

 Click Open Workspace 

 Select the workspace you want to open. 

 View your saved workspaces and layouts. 

You can share content with your colleagues or other Messenger contacts – just click Share. 
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Getting alerts for market-moving events 

Get informed immediately of market-moving information with Alerts.  

 Click in the top right of the toolbar to open Alerts. 

 

 Click Create New Alert. 

 

 Choose the type of data or event to trigger the alert. 

 Fill in the alert criteria. For example, you can receive an alert when the instrument price hits a certain 

threshold. You can easily combine criteria, and Autosuggest helps you find the right instrument quickly. 

 Choose how you want to receive alerts. 

 Click Set to activate your alerts. 
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 You can set alerts directly from other apps. Just right-click the instrument you are interested in and choose 

Set Alert. 

 For eLearning, choose Creating and Managing Alerts from the Price & News Discovery category in the 

Training App. 

Syncing your desktop to your mobile device with My Briefcase 

With My Briefcase, you can collect news and documents and read them later, either on your desktop 

application or from your mobile device, even when you are offline. You can open My Briefcase by clicking  

in the top right of your toolbar. 

1. Open an app and display filings, research, events, or news. For example, country news is available in 

> Markets > Countries & Regions. 

2. Click Add to Briefcase.  

 

3. Sign into your mobile device.  

4. Go to Briefcase in the Applications 

menu to find the article you saved.  

 For eLearning, choose Using the 

Briefcase from the Price & News 

Discovery category in the Training App. 
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Monitoring your portfolios 

Making a portfolio or list 

Lists are sets of financial instruments that you define. Portfolios are predefined or custom lists that include the 

quantity of each financial instrument, as well as historical purchase prices. You can: 

• create lists and portfolios 

• use predefined portfolios, for example, based on major stock indices 

• share them with other colleagues 

• reuse them in other apps, or on your mobile device 

• export them to Microsoft Excel 

 Open Portfolios and Lists. 

Remember, you can open an app from the app menu, or find it using the Search box. 

 In this example, let’s make a portfolio. On the Portfolios And Lists tab, click Create.  

 

2
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 Enter details for your new portfolio, including a name, benchmark index, primary asset class, and currency. 

 Click Create to make your new empty portfolio. On the next screen, you will add instruments and other 

details. 

 Use the tabs at the top of the app to run analytics, create reports, search for news about the instruments in 

your portfolio, and more. 

 Add holdings to your portfolio here. You can then indicate transaction dates and values on the Transactions 

tab. 

 

 Refinitiv Integration Services can help upload your portfolios easily. Contact your Refinitiv representative. 

5
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Following news that affects your portfolio 

News Discovery offers different insight into NewsWires, Global Press, and Reuters Top News through data 

visualization. 

• Get streaming and historical news enhanced by charts, videos, tweets, and more. 

• Charts and story snippets in the headline dashboard tell you the crux of the story at a glance. 

• View news on the companies in your portfolios. 

• Filter by story sentiment (NewsWires only), or by date and time. 

• Add advanced filters and save them just as you do in News Monitor. 

• Create filters, order by date/time or sentiment, or simply view news for the current day. 

News Discovery is available in the News & Research app menu, or by typing NEWSD in the Search box. 

 

 Choose how you want to filter news. In this example, let’s filter by portfolio. 

 Select the portfolio you want. All news articles related to instruments in your portfolio are displayed. 

 Hover over the top right of an article to display the Briefcase icon. Click Add to Briefcase to save your article 

so that you can read it on the go from your mobile device or web browser. 

 Select the news sources you require, and add advanced filters in this area. 

 Use the Timeline toggle button to display news in reverse chronological order or based on the date and time 

criteria you have chosen. 

1
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Watching the markets with Monitor 

Monitor lets you watch instruments and multiple portfolios. You can create and modify your Monitor quickly and 

easily, choosing data fields from the Refinitiv Eikon database and sharing your list with colleagues. 

You will find Monitor in the Monitoring app menu. 

Remember, you can open an app from the app menu, or find it using the Search box. 

To create your instruments, launch Monitor and just start typing. Enter ticker symbols, or type a company name 

and choose from Autosuggest. 

 

 Press Enter to go to the next line, Delete to delete a row, Insert to add one, Ctrl-z to undo an action, or Ctrl-

y to redo one. 

 Right-click a header to sort data or add columns. Also use the right-click menu to access display preferences. 

 You can create multiple Monitor lists. The app saves your changes automatically. To access saved lists or to 

rename lists, click the app menu and choose File > Open or Rename. 

 For indices, you can expand or contract the list of constituents by clicking the grey arrow. 

 Double-click a header name to change the data field. Autosuggest helps you find the Refinitiv data you are 

looking for. 

For eLearning, choose Monitor your Portfolios and Lists from the Price & News Discovery category in the 

Training App. 
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Charting and technical analysis 

Using a Workflow chart 

Workflow charts are predefined charts for various asset classes. You can find them under Charting. 

 Click to open the app menu.  

 Click Charting. Workflow charts for your asset 

class appear, along with Chart App. 

 Select a chart, for example, select Volatility 

Chart. 

 

 

 

 

 

 Fill in the instrument, analysis 

parameters, and other settings. 
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Creating a custom chart in Chart App 

Chart App is a powerful, flexible tool for technical analysis. Build your analysis from scratch and configure it to fit 

your needs. 

 Open the app menu.  

 Click Charting. Workflow charts for your asset 

class appear, along with Chart App. 

 Select Chart. 

 

 

 

 

 

 Type an instrument code and 

press Enter. 

 Use toolbar buttons to adjust 

your chart range, interval, and 

line types.  

 Click on the Analysis button to 

add a new analysis. 

 

 

 

 

 

 

 In the Insert Analysis 

dialog box, select an 

analysis. 

 Click Add to insert it. 

To find out more about 

an analysis, select it 

and press F1 to open 

online help. 

 To edit your chart, just 

click any label and 

choose a new setting 

from the drop-down 

box that appears. 

 For eLearning, 

choose Getting Started with the Chart App from the Charting category in the Training App. 
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Financial communities 

Using Refinitiv Messenger 

 Click the Messenger button on the toolbar to open Messenger. 

 

 Begin typing 

here to search 

the directory or 

your contacts. 

 Right-click a 

contact name 

to view their 

profile, or 

double-click to 

start a 

conversation. 

 View active 

conversations 

in this area. 

 Use these 

buttons to add 

a contact, 

create a group, 

or send a blast. 

 Tip: Messenger 

is enhanced 

every month 

with new features. 

To find out about new enhancements, don’t forget to check the What’s New page frequently. Just click the New 

button in the top right of your toolbar. 

For eLearning, choose Getting Started with Eikon Messenger from the Collaborating category in the Training 

App. 

Contacting Customer Support for help 

 If you need help, you can contact Refinitiv Customer Support anytime from Messenger. Just click the 

Customer Support button at the top-right of the window. 
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Sending messages directly from the Search box 

You can send a quick message to any of your contacts (including Customer Support) without opening Messenger. 

 Just type @ and your contact’s name in the Search box. 

 

 Then type your message and press Enter. 

 

 Tip: You can also write to chat rooms and groups you create in your list of contacts. 

Searching the directory, viewing profiles, and building your 
network 

Messenger gives access to a global financial services directory for the combined Refinitiv Eikon and Markit 

Collaboration Services networks. This is the financial services industry’s first open, cross-network directory. It 

enables users across the industry – including those on internal networks – to find and communicate with each 

other safely and compliantly. 

Over 250,000 users are now accessible across the combined Eikon and Markit networks. 

1. In Messenger, begin typing to search for a person or company.  

2. Right-click a name to view more details.  

3. Click the person’s name to view their profile. 

On the profile page: 

o See the person’s profile and contact details  

o Add the person as a contact  

o Send a message via Messenger or email  
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Refinitiv Eikon – Microsoft Office 

Discovering Refinitiv Eikon – Microsoft Office 

Refinitiv – Microsoft Office, an integral part of Eikon, is a self-installing Microsoft Excel add-in. With it, you can: 

• retrieve real-time, historical, and fundamental data by using the Formula Builder or the In-Cell Builder 

• analyze equities using the integrated Screener 

• build charts with your financial data in your worksheets for market analyses 

• access and customize advanced templates provided by Refinitiv 

• build lists and portfolios, and access those created in Refinitiv Eikon Desktop 

• export and link Excel data and charts to documents or presentations in Word or PowerPoint 

• create presentations and documents customized to your company’s own visual identity 

Logging into Refinitiv Eikon – Microsoft Office 

1. Start Microsoft Excel. 

2. Click the Refinitiv tab  to open the Refinitiv Eikon menu. 

3. Click Sign in  and type your Refinitiv Eikon credentials if prompted. 

 

Open the Training App and choose the Excel & Analytics category to see the full range of training materials for 

Refinitiv Eikon – Microsoft Office, from basic features to advanced data retrieval and automation. 

Using the Formula Builder to retrieve Refinitiv data 

1. Select a blank cell on your worksheet , then click Build Formula  on the Refinitiv tab. 

 

1
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2. In the Formula Builder, enter (or search for) the instruments you want data for . 

3. Select the data source you require (real-time & fundamental or time series), then enter the data item(s) you 

want to include . For each data item, you can define settings in the Parameters area.  

4. Select other settings, if required.  

5. Click Insert.  

 

The worksheet embeds the new formula in the cell you selected, and retrieves the related data. 

6. In this example, the TR function  is used.  
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Enabling Datastream, Deal Analytics, Linking, and Presentation 
Tools 

Refinitiv Eikon – Microsoft Office includes additional apps to enhance your productivity. 

Note: You must be permissioned to enable these apps. 

 Click Add-Ons on the Refinitiv Eikon tab. 

 

 

 Click to read about the 

apps. 

 Click the Enable button 

next to the apps you 

require. 

o Analyze This 

o Datastream 

o Datastream Charting 

o Deal Analytics 

o Deals Business 

Intelligence 

o Linking 

 

 

 

Using Adfin Analytics and other advanced features 

Adfin Analytics is a set of powerful cross-market financial calculation libraries. The libraries are targeted for 

financial spreadsheet users and developers of financial applications. The libraries can be used in different 

environments, for example in Refinitiv Eikon – Microsoft Office. 

 Tip: In Microsoft Excel, go to Formulas > Insert Function to access the Adfin Analytics functions. 

For eLearning, choose Getting Started with Eikon – Microsoft Office from the Excel & Analytics category in the 

Training App. 
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